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PDF books and the information center

PDF books are provided as a convenience for printing and offline reading. For the latest information, see
the online information center.

As a set, the PDF books contain the same content as the information center. Some links within the PDF
books have been tailored for use in the information centers and may not work properly.

The PDF documentation is available within a quarter after a major release of the information center, such
as Version 7.0 or Version 7.5.

The PDF documentation is updated less frequently than the information center, but more frequently than
the Redbooks®. In general, PDF books are updated when enough changes are accumulated for the book.
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Installing IBM Integration Designer

This installation information provides instructions for installing and uninstalling IBM® Integration
Designer V7.5.1 and optional features.

Refer to the IBM Integration Designer release notes file for information about product limitations, known
problems, and workarounds.
Related information:

IBM Installation Manager information center

Overview
This installation information provides instructions for installing, updating and uninstalling IBM
Integration Designer using IBM Installation Manager.

Refer to the IBM Integration Designer support site for updated documentation and troubleshooting
information.

IBM Installation Manager
IBM Installation Manager is a program that helps you install the IBM Integration Designer packages on
your workstation. It also helps you update, modify, and uninstall this and other packages that you install.
A package can be a product, a group of components, or a single component that is designed to be
installed by the Installation Manager.

IBM Installation Manager offers a number of time-saving features. It keeps track of what you are about to
install, software components that you have already installed, and components that are available for you
to install. It searches for updates so you know that you are installing the latest version of an IBM
Integration Designer product package. Installation Manager also provides tools for managing licenses for
the product packages that it installs. It provides tools for updating and modifying packages. You can also
use Installation Manager to uninstall product packages.

Installation Manager comprises seven wizards that make it easy to maintain your product packages
through their life cycles:
v The Install Packages wizard walks you through the installation process. You can install a product

package by simply accepting the defaults, or you can modify the default settings to create a custom
installation. Before you install a product package, you are provided with a complete summary of the
selections that you have made throughout the wizard. With the wizard you can install one or more
product packages at the same time.

v The Update Packages wizard searches for available updates to product packages that you have
installed. An update might be a released fix, a new feature, or a new version of the product. Details of
the contents of the update are provided in the wizard. You can choose whether to apply an update.

v With the Modify Packages wizard, you can modify specific elements of a package that you have
already installed. During your initial installation of the product package, you select the features you
want to install. If you find later that you require other features, you can use the Modify Packages
wizard to add them to your product package installation. You can also remove features, and add or
remove languages.

v The Manage Licenses wizard helps you to set up the licenses for your packages. Use this wizard to
change your trial license to a full license, to set up your servers for floating licenses, and to select
which type of license to use for each package. This wizard is not used for the IBM Integration Designer
packages.
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v The Import wizard helps you to add existing packages that were installed using installation tools other
than Installation Manager so that they can be managed by Installation Manager.

v With the Roll Back Packages wizard you can revert to a previously installed version of an eligible
package.

v The Uninstall Packages wizard helps you to remove a product package from your computer. You can
uninstall more than one package at a time.

Planning to install
Planning for IBM Integration Designer before introducing its software into your enterprise information
system helps ensure that the system you implement meets your needs. This section describes how to plan
for IBM Integration Designer.

Test environment
You have the option to use either a local test environment or a remote one. Developers using systems that
are constrained on resources (CPU, memory, disk space) should consider configuring a remote test
environment and pointing their IBM Integration Designer at that remote environment for testing their
processes and monitor models.

As an IBM Integration Designer developer, how you set up a remote environment depends on your target
deployment environment.

Process Server

With a Process Server test environment for unit testing, the server can be installed locally or on a remote
machine. When Process Server is installed locally, IBM Integration Designer finds it and displays it in the
Servers view. When Process Server is installed remotely, you can target it from IBM Integration Designer
by creating a new server.
1. In the Servers view, right-click and select New > Server.
2. Select IBM > IBM Process Server v7.5.
3. Specify the remote server host name and click Next.
4. Specify the profile name, connection, and security information, and click Finish.

Process Server via Process Center

If you have a Process Server test environment for unit testing, the server can be installed locally or on a
remote machine, as described above. If you have only Process Center, you can switch to the Process
Center perspective and are prompted for connection information to the Process Center. To target a remote
server:
1. In the Process Center, select Window > Preferences.
2. Select Business Integration > Process Center.
3. Specify the Process Center URI, user name, and password.
4. Click Test Connection. If everything is correct, click OK.

If you experience communication problems with the remote server, such as problems in publishing to the
remote server or obtaining the status of the server, see Resolving communication problems with remote
servers.

Installing to a unique package group

To install IBM Integration Designer and the test environment to a unique package group on the same
system with an existing Rational® Application Developer 8.0.x installation, complete the following steps:
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1. Install IBM Integration Designer before you install the test environment. Installation Manager displays
the choice of whether to install into a new package group or into the existing Rational Application
Developer 8.0.x package group.

2.

3. Install the test environment after you have installed IBM Integration Designer.

Security considerations
In IBM Integration Designer V7.5.1, both administrative security and application security are enabled by
default.

Server security, including administrative security and application security, is automatically enabled for
those test environment servers that you choose to install with IBM Integration Designer V7.5.1.

Important: Application security is required by IBM Business Process Manager and must not be turned off
in the administrative console.

During installation of the test environment you are prompted for a user name and password to be used
for administering server security.

Note that if you disable or enable server security in a server administrative console, you must ensure that
these changes are also specified for the same server in the server configuration editor or the Window >
Preferences > Server > Security preferences page of IBM Integration Designer.

Information about changing the user ID and password, and about disabling or enabling server security, is
found in the Security documentation in the IBM Integration Designer help: Help > Help Contents > IBM
Integration Designer > Managing security.

Coexistence considerations
If you plan to install multiple IBM Eclipse-based products on the same workstation, review the
information in this section.

Offering coexistence considerations
Some products are designed to coexist and share function when they are installed in the same package
group. A package group is a location where you can install one or more software products or packages to
share a common user interface or workbench. When you install each package, you select whether you
want to install the package to an existing package group, or whether you want to create a new one. IBM
Installation Manager will block products that are not designed to share a package group or do not meet
version tolerance and other requirements. If you want to install more than one product at a time, the
products must be able to share a package group.

Any number of eligible products can be installed to a package group. When a product is installed, its
function is shared with all of the other products in the package group. If you install a development
product and a testing product into one package group, when you start either of the products, you have
both the development and testing functionality available to you in your user interface. If you add a
product with modeling tools, all of the products in the package group will have the development, testing,
and modeling functionality available.

If you want IBM Integration Designer V7.5.1 to coexist with a Rational software product (for example,
Rational Application Developer for WebSphere® Software), the Rational software product must be at
version 8.0.3 or higher. When you have an earlier version of the Rational software product you must
correct this incompatibility by updating the version to 8.0.3 or higher, or choose a new package group.
When you want to add a Rational software product to the same package group as IBM Integration
Designer V7.5.1, you must install it directly at the required 8.0.3 (or higher) level by searching for
available updates during the Rational installation (using Check for Other Versions and Extensions), or
by pointing to the 8.0.3 update repository location along with the base Rational repository location.
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For more information on coexisting with Eclipse-based products see Planning for IBM Integration
Designer to coexist with other Eclipse-based products

Note: Each product installed into a unique location may be associated with only one package group. A
product must be installed into multiple locations in order to be associated with multiple package groups.

Coexisting installations of IBM Integration Designer
You can install IBM Integration Designer V7.5.1 on to a system with an existing installation of IBM
Integration Designer V7.5.1, but the two cannot be part of the same package group.

Similarly, you can install IBM Integration Designer V7.5.1 on to a system with an earlier installation of
IBM Integration Designer, but the two cannot be part of the same package group.

Nonadministrative user considerations
If you are installing IBM Integration Designer as a nonadministrative or nonroot user, you must have the
DB2 server installed before you begin the installation. Remember the database details so that you can
enter them during the installation.

The considerations described in this topic apply to any install scenario where you choose to install using
the Typical install option. Profiles are created automatically when you install using the Typical option.

To install as a nonadministrative user, you have the following choices: 2000Linux 2000Windows

v Before installing the product, install a DB2 server separately. For information about installing DB2 as a
nonadministrative or nonroot user, see 2000Linux 2000Windows

– 2000Linux Non-root installation overview (Linux and UNIX)

– 2000Windows Required user accounts for installation of DB2 server products (Windows)
v Logon as an administrator and use the product installer to install the DB2 server alone. Grant special

permission to the nonadministrative user. Then logon as the nonadministrative user and install the
product using the installed DB2 server.

Note: If you choose to use the DB2 Express database included (and optionally installed) with the
product, you must meet the following criteria:
v Uninstall any other versions of DB2 from the system
v Install IBM Business Process Manager as a nonadministrative or nonroot user

Preparing to install
There are a few tasks which should be completed before beginning the installation process.

Previous versions of IBM Integration Designer cannot be upgraded to V7.5.1. Different versions of IBM
Integration Designer can coexist on your workstation, but they must not be installed in the same
directory.

Before you install the product, complete these steps:
1. Confirm that your system meets the hardware and software requirements described in System

requirements for IBM Integration Designer.
2. Read the section “Planning to install” on page 2 and give particular attention to the topic

“Coexistence considerations” on page 3.
3. Prepare your operating system following the instructions.

Preparing Linux systems for installation
Before you can install IBM Integration Designer, you must prepare your Linux operating system.
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Because WebSphere Application Server is a prerequisite of IBM Integration Designer, you must complete
all the required preparation steps in the Preparing the operating system for product installation topic in
the WebSphere Application Server information center.

Note: However, please note the following points related to the WebSphere Application Server installation:
v The WebSphere Application Server Network Deployment V7.0 that is installed by IBM Integration

Designer V7.5 uses IBM Installation Manager to install and does not use InstallShield Multiplatform
(ISMP). Ignore any prerequisite instructions that refer specifically to running ISMP.

v The WebSphere Application Server Network Deployment V7.0 that is installed by IBM Integration
Designer V7.5 uses IBM Installation Manager to install fix packs and interim fixes and does not use the
WebSphere Update Installer. Ignore any prerequisite instructions that refer specifically to running the
WebSphere Update Installer.

Ensure that you have Mozilla Firefox installed at version 3.5.x.x or higher.

Because certain steps are specific to a version of the operating system, all steps might not apply to your
environment. If no qualifier is provided for a particular step, complete the step for all versions of the
operating system. To install Installation Manager on Red Hat Enterprise Linux 6.0 (64-bit), see Unable to
install Installation Manager on RHEL 6.0 (64-bit).

If you are planning to install IBM Integration Designer using DB2 Express with Red Hat Enterprise Linux
6, you must have administrative privileges (root user), must not have an existing DB2 database server on
the system, and you must also ensure that all kernel requirements are met before the DB2 Express
installation begins. You can locate the current values by parsing the output of the ipcs -l command.

To change the values:
1. Add the following lines, in the below order, to the /etc/sysctl.conf file:

kernel.shmmni=4096
kernel.shmmax=4294967296
kernel.shmall=8388608
#kernel.sem=<SEMMS><SEMMNS><SEMOPM><SEMMNI>
kernel.sem=250 256000 32 4096
kernel.msgmni=16384
kernel.msgmax=65536
kernel.msgmnb=65536

2. Add the following lines to the end of /etc/security/limits.conf:
# - stack - max stack size (KB)
* soft stack 32768
* hard stack 32768
# - nofile - max number of open files
* soft nofile 65536
* hard nofile 65536
# - nproc - max number of processes
* soft nproc 16384
* hard nproc 16384

3. Check for the existence of a file named /etc/security/limits.d/90-nproc.conf, which overrides the
nproc value set in the limits.conf file. If the 90-nproc.conf file exists, edit it and set the nproc
values that are specified in the previous step.

4. Reboot your system.

Complete the following steps on your Linux system before installing IBM Integration Designer:
1. If you are installing 32-bit WebSphere Application Server on a 64-bit operating system, ensure that the

appropriate 32-bit libraries are installed on your 64-bit system.
2. If you are planning to install IBM Integration Designer using DB2 Express with Red Hat Enterprise

Linux 6 as a root user, follow the previous instructions and skip this step. Otherwise, increase the
maximum number of open files to at least 8800. The default setting is usually not enough. You can
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check your current maximum number of open files by using ulimit -n. The following example shows
the maximum number of open files being increased to 8800, which is large enough for most systems.
The ulimit requirement is dynamically calculated at installation time and might need to be larger
based on the options you select.
a. Open /etc/security/limits.conf.
b. Locate the nofile parameter and increase the value. If a line containing the nofile parameter does

not exist, add the following lines to the file:
* hard nofile 8800

* soft nofile 8800

c. Save and close the file.
d. Log off and log in again.

For more information about this setting, run man limits.conf or see the Preparing the operating
system for product installation topic in the WebSphere Application Server information center.

3. Install the following packages for your operating system:

Option Description

Red Hat Enterprise Linux 5 compat-libstdc++-33-3.2.3-61

compat-db-4.2.52-5.1

libXp-1.0.0-8

rpm-build-4.4.2-37.el5

64-bit kernel only: compat-libstdc++-296-2.96-138

Red Hat Enterprise Linux 6 ksh-version.rpm Korn shell

See the detailed instructions and list of packages in
Unable to install Installation Manager on RHEL 6.0
(64-bit)

SUSE Linux Enterprise Server 9.0 XFree86-libs-32bit-9

glibc-32bit-9

glib-32bit-9

gtk-32bit-9

You can also install a later release of any of these packages if there are new packages as errata. If you
have additional packages that are specific to your hardware, install them.
You can use single-line commands to install dependencies (all required packages). The following
commands are examples using the default package managers on supported Linux distributions.
v Red Hat Enterprise Linux 5 (32-bit):

yum install compat-libstdc++-33 compat-db libXp rpm-build RHEL 5.x

v Red Hat Enterprise Linux 5 (64-bit):
yum install compat-libstdc++-33 compat-db libXp rpm-build compat-libstdc++-296

v SUSE Linux:
zypper install XFree86-libs-32bit-9 glibc-32bit-9 glib-32bit-9 gtk-32bit-9

4. Set the umask value to 077 using the following command:
umask 077

The value 077 is the most restrictive value that the product will tolerate. You can optionally choose to
set a less restrictive umask value for the following access levels:
v 037 for read-only access for a group of human administrators and tools
v 027 for read and write access for a group of human administrators and tools
v 007 for read, write, and execute access for a group of human administrators and tools

5. On Red Hat Enterprise Linux 5 systems, disable SELinux, or set it to a permissive mode.
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6. Restart the computer.
7. Complete the steps to Tune Linux systems.
8. Ensure all servers involved are set to the same time. Use the same network time protocol for all

servers on all cluster nodes, including application, support, and database clusters. A time mismatch
will cause erratic behavior, including duplicate system tasks.

Preparing Windows systems for installation
Before you can install IBM Integration Designer, you must prepare your Windows operating system.

Because WebSphere Application Server is a prerequisite of the IBM Integration Designer test environment,
you must complete all the required preparation steps if you plan to use the test environment.

If you plan to use the test environment, complete the following steps on your Windows system before
installing IBM Integration Designer:
1. Complete the below steps for the installation of WebSphere Application Server.

a. Download and install a Web browser. You must install a Web browser if you want to use the
launchpad application. If your system does not have a default browser or the browser has been
corrupted or installed incorrectly, then you might experience errors when trying to open various
hyperlinks in the installation wizard panels.

b. If you are installing 32-bit WebSphere Application Server on a 64-bit operating system, ensure that
the appropriate 32-bit libraries are installed on your 64-bit system.

c. Stop all WebSphere Application Server-related Java processes on the machine where you are
installing the product.

d. Stop any Web server process such as the IBM HTTP Server.
e. Stop all instances of the process_spawner.exe program. You can skip this step if

the process_spawner.exe does not exist.The process_spawner.exe is a required binary for the
WebSphere Application Server to function properly. The process_spawner.exe is not intended to
be called directly and is a core functionality of the WebSphere Application Server on Windows.

f. Provide adequate disk space. The amount of disk space required varies with the number of
features or products installed. If you are installing the product using the installation wizard, the
installation summary panel indicates the approximate amount of disk space required based on the
features and products you have selected.If you plan to migrate applications and the configuration
from a previous version, verify that the application objects have enough disk space. As a rough
guideline, plan for space equal to 110 percent of the size of the applications.

g. Verify that prerequisites and corequisites are at the required release levels. Although the
installation wizard checks for prerequisite operating system patches, review the prerequisites on
the if you have not done so already. Refer to the documentation for non-IBM prerequisite and
corequisite products to learn how to migrate to their supported versions.

The WebSphere Application Server installation uses an IBM Installation Manager wizard. You can use
the graphical interface of the wizard. You can also use the wizard in silent mode. If you are installing
remotely and want to use the installation wizard, then you must use a connection mechanism that
supports the use of graphics. If your connection does not support the use of graphics, then install the
product silently.
To run the install successfully, you must have write permissions to the USER_HOME directory. If you
do not have permission to write to USER_HOME, then be aware of the following install limitations:
v The Profile Management Tool GUI will not function due to a requirement to write to

USER_HOME. You must use the manageprofiles on the command-line to manage profiles instead.
2. Complete the steps to Tune Windows systems.
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Installing from the product launchpad
The product launchpad program provides you with a single location to view release information and
start the installation process.

Complete the preinstallation tasks described in “Preparing to install” on page 4, if you have not done so
already.

Important: If you are installing IBM Integration Designer with its test environment as a
nonadministrative or nonroot user and you intend to install the test environment, you must install DB2
before you begin the product installation

2000Windows To install or run IBM Integration Designer on Windows 7, Windows Vista, or Windows Server
2008, you must elevate your Microsoft Windows user account privileges. Whether you are an
administrative user or a non-administrative user, right-click launchpad.exe and select Run as
administrator.

Use the product launchpad program to start the installation of IBM Integration Designer in the following
cases:
v Installing from the product DVDs
v Installing from an electronic installation image on your local file system
v Installing from an electronic installation image on a shared drive

When you start the installation process from the launchpad program, IBM Installation Manager is
automatically installed if it is not already on your computer, and it is automatically configured with the
location of the repository that contains the IBM Integration Designer package. If you install Installation
Manager by itself and then use it to install IBM Integration Designer, then you must set the repository
locations for IBM Integration Designer manually. See Specifying repository locations for details about how
to set repository preferences in Installation Manager.

To start the launchpad program, complete the following steps:
1. Insert the first IBM Integration Designer DVD into your DVD drive.

2000Linux Ensure that you have mounted the DVD drive.Alternatively, extract all the files from the
downloadable images. All files should be extracted to the same location on your hard drive.
Overwrite directories if prompted.

2. If auto-run is enabled on your system, the IBM Integration Designer launchpad program
automatically opens. If auto-run is not enabled on your system or you are not using a DVD:
v Run launchpad.sh located in the root directory of the DVD or extracted files.
v Run launchpad.exe, or launchpad64.exe for a 64-bit system, located in the root directory of the

DVD or extracted files.
3. If you are in the Administrator group on Windows, or if you are a root user on a Linux system,

ensure that Install as administrative user is selected. Clear this check box only if you are not an
administrative user, or if you want to install to your own user name without giving privileges to
other users.

4. Select the typical installation environment that you want. Based on your selection, your workspace
and the Welcome screen are configured to emphasize the functions that you need. You can change
your environment at a later time in IBM Integration Designer. See “Typical installations and
environments” on page 9 for more information.

5. Click Install Selected to begin the installation. IBM Installation Manager launches, or installs and then
launches.

6. Install the product according to the instructions in “Installing with IBM Installation Manager” on page
10.
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You can click Help System Installation on the launchpad to install the information center.
Related information:

IBM Installation Manager information center

Typical installations and environments
You select a typical installation configuration from the launchpad when you install IBM Integration
Designer. The preselected configuration you select determines the environment that will be enabled when
IBM Integration Designer starts. You can change the configuration selections during installation or run
Installation Manager at a later time to make changes. You can also change your environment later in IBM
Integration Designer.

IBM Integration Designer for IBM Business Process Manager Advanced - Process
Server

This installation configuration includes an IBM Process Server test environment, and also supports
WebSphere Enterprise Service Bus and optionally IBM Business Monitor. The following packages are
selected for installation:
v WebSphere Application Server Network Deployment
v WebSphere Application Server Feature Pack for Service Component Architecture
v WebSphere Application Server Feature Pack for XML
v IBM Business Process Manager Advanced - Process Server
v DB2 Express
v Integration Designer

A default stand-alone profile for IBM Business Process Manager Advanced - Process Server is selected on
the Features page. This profile enables you to begin using the test environment immediately.

By default, Start working with the IBM Process Center first is selected so that you can work with the
Process Center, a scalable central repository and control center for organizing and managing process
artifacts, applications, and services.

IBM Integration Designer for WebSphere Enterprise Service Bus

This installation configuration includes a IBM Integration Designer test environment, and also optionally
supports IBM Business Monitor. The following packages are selected for installation:
v WebSphere Application Server Network Deployment
v WebSphere Application Server Feature Pack for Service Component Architecture
v WebSphere Application Server Feature Pack for XML
v IBM Business Process Manager Advanced - Process Server
v DB2 Express
v Integration Designer

A default stand-alone profile for WebSphere Enterprise Service Bus is selected on the Features page. This
profile enables you to begin using the test environment immediately.

2000Windows

IBM Integration Designer for IBM Business Monitor

For Windows only, this installation configuration includes IBM Business Monitor, the Monitor Model
editor (a feature in IBM Integration Designer, and a IBM Business Monitor test environment. The
following packages are selected for installation:
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v WebSphere Application Server Network Deployment
v WebSphere Application Server Feature Pack for XML
v Business Monitor
v IBM Cognos Business Intelligence
v DB2 Express
v Integration Designer

A default stand-alone profile for Business Monitor is selected on the Features page. This profile enables
you to begin using the test environment immediately.

IBM Integration Designer for WebSphere DataPower

This installation configuration works directly with the WebSphere DataPower Appliance, and does not
include a test environment. Only the Integration Designer package is selected for installation.

IBM Integration Designer

This installation configuration does not include a test environment. Only the Integration Designer
package is selected for installation.

IBM Forms

You can use IBM Integration Designer to build business applications that involve human tasks. These
tasks are performed by people and thus require user interfaces. There are a variety of technologies that
can be used for these user interfaces, and one option is to use IBM Forms.

To install the software you require to view, create and edit IBM Forms, see "Installing IBM Forms
software.".
Related tasks:
“Installing IBM Forms software” on page 17
The IBM Forms software is included with IBM Integration Designer, and can optionally be installed.

Installing with IBM Installation Manager
You can install IBM Integration Designer interactively using the Installation Manager.

Important: If you are installing IBM Integration Designer with its test environment as a
nonadministrative or nonroot user and you intend to install the test environment, you must install DB2
before you begin the product installation

If you are installing this product using the launchpad, then Installation Manager has automatically been
started and configured for you, so you can skip directly to Step 2.

Tip: If you try to install IBM Integration Designer and the test environment on a system with an existing
Rational Application Developer 8.0.x installation, Installation Manager only displays the option for you to
select the same package group in which Rational Application Developer 8.0.x is installed. To install IBM
Integration Designer and the test environment to a different package group, install IBM Integration
Designer before you install the test environment. Installation Manager displays the choice of whether to
install into a new package group or into the existing Rational Application Developer 8.0.x package group.
After you have installed IBM Integration Designer, you can then install the test environment.
1. Optional: If you are NOT installing from the launchpad, complete the following steps:

a. Start Installation Manager from the Windows Start Menu or from a command line. See Starting
Installation Manager for instructions.
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Note: If a newer version of Installation Manager is found, you are prompted to confirm that you
want to install it before you can continue. Click OK to proceed. Installation Manager
automatically installs the new version, restarts, and resumes.

b. Define the repository locations according to the instructions in Specifying repository locations.
The repository locations are image_directory/disk1/IMwid75/repository.config (for IBM
Integration Designer) and image_directory/WTE_Disk/repository/repository.config (for the test
environment), where image_directory contains the extracted installation image for IBM Integration
Designer.

c. From the Installation Manager Start page, click Install.
2. The Install page of the Install Packages wizard lists all the packages found in the repositories that

Installation Manager searched. If two versions of a package are discovered, only the most recent, or
recommended, version of the package is displayed.
v To display all versions of any package found by Installation Manager, select the Show all versions

check box.
v To return to the display of only the recommended packages, clear the Show all versions check

box.
3. To search for updates to the IBM Integration Designer package, click Check for Other Versions,

Fixes, and Extensions.

Note: For Installation Manager to search the predefined IBM update repository locations for the
installed packages, the preference Search service repositories during installation and update on the
Repositories preference page must be selected. This preference is selected by default. Internet access
is also required.
Installation Manager searches for updates at the predefined IBM update repository for the product
package. It also searches any repository locations that you have set. A progress indicator shows the
search is taking place. You can install updates at the same time that you install the base product
package.

4. If updates for the IBM Integration Designer package are found, then they will be displayed in the
Installation Packages list on the Install Packages page below their corresponding product. Only
recommended updates are displayed by default.
v To view all updates found for the available packages, select the Show all versions check box.
v To display a package description under Details, click on the package name. If additional

information about the package is available, such as a readme file or release notes, a More info link
is included at the end of the description text. Click the link to display the additional information
in a browser. To fully understand the package you are installing, review all information
beforehand.

5. Ensure that the IBM Integration Designer package is selected and any updates to the package that
you want to install. Updates that have dependencies are automatically selected and cleared together.
A set of packages are selected for you based on the installation configuration that you selected. You
might have to make the following changes to this set:
v Select IBM Forms Designer if you want to create IBM Forms as the user interface to your human

tasks.
v Clear the check box for IBM Cognos Business Intelligence if you are using Windows and are not

an administrative user.
v Clear the check box for DB2 Express if you already have a local database installed or if you are

not an administrative user.

Click Next.

Note: If you install multiple packages at the same time, then all the packages will be installed into
the same package group.
If you receive the following warning message during the prerequisite checking, use the
platform-specific steps below to increase the ulimit number.
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Current system has detected a lower level of ulimit than the recommended value of recommended_value. Please increase the ulimit number to minimum value of recommended_val

Shutdown your installer. If you are a root user open a command prompt and issue ulimit -n recommended_value and then restart the installer. If you are a non-root user, wo

The required value is calculated based on the version of WebSphere Application Server, the feature
packs, and the configuration that you are installing.

Set the maximum number of open files using the following command: 2000Linux

a. Open /etc/security/limits.conf.
b. Locate the nofile parameter and increase the value. If a line containing the nofile parameter does

not exist, add the following lines to the file:
* hard nofile recommended_value

* soft nofile recommended_value

c. Save and close the file.
d. Log off and log in again.

6. On the Licenses page, read the license agreement for the selected packages.
If you selected more than one package to install, there might be a license agreement for each
package. On the left side of the License page, click each package version to display its license
agreement. The package versions that you selected to install (for example, the base package and an
update) are listed under the package name.
a. If you agree to the terms of all of the license agreements, click I accept the terms of the license

agreements.
b. Click Next to continue.

7. If IBM Integration Designer V7.5.1 is the first package installed using Installation Manager, type the
path for the shared resources directory in the Shared Resources Directory field on the Location page,
or accept the default path. The shared resources directory contains resources that can be shared by
one or more package groups.

Important:

a. You can specify the shared resources directory only the first time that you install a package. Use
your largest disk for this to help ensure adequate space for the shared resources of future
packages. You cannot change the directory location unless you uninstall all packages.

b. Ensure that your installation path does not contain parentheses.

c. 2000Linux Ensure that your installation path does not contain spaces.
Click Next to continue.

8. On the next Location page, you can create a package group to install the IBM Integration Designer
package into, or use an existing package group. A package group represents a directory in which
packages share resources with other packages in the same group. By default, a new package group is
created for IBM Integration Designer V7.5.1. If Installation Manager is aware of another package
group, the Use the existing package group option is available for selection. To create a new package
group:
a. Select Create a new package group.
b. Enter the path for the installation directory for the package group. Ensure that your installation

path does not contain parentheses. ( 2000Linux Ensure that you do not include any spaces in the
directory path). The name for the package group is created automatically.
The default installation path is:

v 2000Windows C:\IBM\IntegrationDesigner\v7.5

v 2000Linux root: /opt/IBM/IntegrationDesigner/v7.5

v 2000Linux nonroot: user_home/IBM/IntegrationDesigner/v7.5
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c. If you are creating a test environment, you might want to change the default path for the test
environment. Select WebSphere Application Server - ND and enter the path for the test
environment. For example, if you are installing the IBM Business Process Manager Advanced -
Process Server, you might change the path to: C:\IBM\Process Server\v7.5.
The default test environment installation path is:

v 2000Windows C:\Program Files\IBM\WebSphere\AppServer

v 2000Linux root: /opt/IBM/WebSphere/AppServer/

v 2000Linux nonroot: user_home/IBM/WebSphere/AppServer/
d. Click Next to continue.

9. On the Languages page, choose all the languages that you would like to be able to have supported
when you use this software, and click Next.

10. On the Features page, select the package features that you want to install. If you did not select it,
then it is not displayed as an installable feature.
a. Optional: To see the dependency relationships between features, select Show Dependencies.
b. Optional: Click a feature to view its brief description under Details.
c. Select or clear features in the packages. Installation Manager will automatically enforce any

dependencies with other features and display updated download size and disk space
requirements for the installation.
v If you expand IBM Integration Designer, you can select from a list of available features. Some

features are already selected based on the installation configuration. If you selected to install
IBM Forms Designer on the Install Packages page, it is displayed and selected here.

v If you expand IBM Business Process Manager Advanced - Process Server or Business
Monitor Server and select one or more stand-alone development profiles, the profiles are
created for you during installation. A profile might already be selected based on the capability
set you chose.
A stand-alone development profile is a default development profile that provides a test
environment. The Process Server development profile also comes with Business Rules Manager
enabled.
If you choose not to install a default stand-alone development profile, you can install one later
by launching the Installation Manager and clicking Modify on the first page.

d. When you are finished selecting features, click Next to continue.
11. If you selected a stand-alone development profile, on the Profiles page, enter the credentials for the

test server that you are creating. The default user name is admin and the default password is admin.
12. If you selected DB2 Express, on the Common Configurations page, enter a user name and password

for DB2 and click Next. The default user name is bpmadmin and the default password is bpmadmin1.

Important: You must change the default password if it does not comply with the password policy
on your operating system (such as Windows 2008).

Restriction: User names must not contain NL strings.
13. On the Summary page, review your choices before installing the IBM Integration Designer package.

If you want to change the choices that you made on previous pages, click Back and make your
changes. When you are satisfied with your installation choices, click Install to install the package. A
progress indicator shows the percentage of the installation completed.

14. When the installation process is complete, a message confirms the success of the process. If you
chose to create a stand-alone development profile during installation and it failed or did not fully
succeed, you see an error message informing you of the failure and giving you the location of the
profile creation error log at install_root/logs/manageprofiles/profilename_create.log. You must
resolve the profile creation problem and create a profile using the Profile Management Tool or the
manageprofiles command.
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a. Click View log file to open the installation log file for the current session in a new window. You
must close the Installation Log window to continue.

b. Depending on whether you selected to install a test environment, you might be given the option
to create a profile when you exit. If you have already created a stand-alone profile as part of the
installation, select None.

c. Click Finish to close the Installation Manager.
Related information:

IBM Installation Manager information center

Available features
You can customize your software product by selecting the features of IBM Integration Designer to install.

When you install the IBM Integration Designer product package using IBM Installation Manager, the
installation wizard displays the features available in the product package. From the features list, you can
select which features to install. A default set of features is selected for you (including any required
features). Installation Manager automatically enforces any dependencies between features and prevents
you from clearing any required features.

Adapters can be individually selected. Only install the adapters that you will require.

Note: After you finish installing the package, you can still add or remove features from your software
product by running the Modify Packages wizard in Installation Manager. See “Modifying installations”
on page 30 for more information.

The following table shows the features of IBM Integration Designer that you can choose to install. Default
selections of features to install may vary. If a feature has already been installed, it will not be selected by
default and will not be installed again.

Table 1. Features of IBM Integration Designer that you can choose to install.

Feature group Feature Description Selected by
default

IBM Installation
Manager

The Installation Manager helps you to install IBM
Integration Designer and related tools.

Yes (mandatory)

2000Windows

IBM Forms
Designer 4.0.0.1

IBM Forms Designer allows you to create and edit IBM
Forms to use as user interfaces to your human tasks.

Yes (This option is
not displayed if
you did not select
to install IBM
Forms Designer
on the first Install
panel of the
Installation
Manager).

IBM Integration
Designer

The core functionality of IBM Integration Designer.
Provides tools in a comprehensive development
environment to build integrated solutions.

Yes (mandatory)

Tools for
developing
applications
without a local
server installation

Select this option if you do not have this server
installed locally but want to develop applications for
IBM Process Server, V7.5.1, or WebSphere Enterprise
Service Bus, V7.5.1, or connect to a remote V7.5.1 of
these servers.

No
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Table 1. Features of IBM Integration Designer that you can choose to install. (continued)

Feature group Feature Description Selected by
default

E-mail, Flat File,
FTP and JDBC
IBM WebSphere
Adapters

Send and receive e-mail to and from an e-mail server
using WebSphere Adapter for Email. Read from, and
write to, a file on a local file system using the
WebSphere Adapter for Flat Files. Read from, and write
to a file on remote system using the WebSphere
Adapter for File Transfer Protocol (FTP). Create and
access services with the database system using
WebSphere Adapter for JDBC.

Yes

Additional IBM
WebSphere
Adapters

Adapters access programs and data on Enterprise
Information Systems (EISs).

No

CICS adapter Create and access services to exchange information
with COBOL, C, PL/I programs and data on Customer
Information Control Systems (CICS) transaction
systems.

No

Domino adapter Create a service that exchanges information with an
IBM Domino server. Create integrated processes, which
can create and access Domino documents, without
special coding. During outbound processing the
adapter supports Create, Retrieve, Update, Delete,
Exists and RetrieveAll operations. The adapter receives
a request in the form of a business object from a
service, it processes the request and sends the response
back to the calling component, during inbound
processing, the adapter polls the Domino server at
intervals for Domino documents that are ready for
processing.

No

ECM Adapter Create and access content in an Enterprise content
management system using WebSphere Adapter for
Enterprise Content Management.

No

IMS Adapter Create and access services to exchange information
with COBOL, C, and PL/I programs and data on IBM
Information Management System (IMS) transaction
systems.

No

iSeries Adapter Create and access services that use the program call
markup language (PCML) standard to call an RPG,
COBOL, and service programs on the target IBM i
machine, and send or receive messages to an IBM i
data queue.

No

JD Edwards
Adapter

Create and access services with the JD Edwards
EnterpriseOne Server using WebSphere Adapter for JD
Edwards EnterpriseOne.

No

Oracle Adapter Create and access services to exchange information
with the Oracle E-Business Suite.

No

PeopleSoft
Adapter

Create and access services to exchange information
with WebSphere Adapter for PeopleSoft Enterprise.

No

SAP Adapter Create and access services to exchange information
with the SAP server.

No

Siebel Adapter Create and access services to exchange information
with the Siebel Business Application Server.

No

WebSphere
Adapter Toolkit

Provides the development tools, libraries, and sample
code to assist you in creating JCA resource adapters.

No
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Table 1. Features of IBM Integration Designer that you can choose to install. (continued)

Feature group Feature Description Selected by
default

2000Windows

Monitor Model
editor

Provides wizards and libraries to help you create
monitor models. It will be installed in your IBM
Integration Designer environment.

Yes

Client
development tools

Most applications require client interfaces through
which customers or staff can enter data. This group of
tools is provided to allow you to create customized
clients for your applications.

No

Web development
tools

Provides tools for building Web 2.0 and Java EE Web
applications using JavaServer Faces (JSF), JavaServer
Pages (JSP), servlets, and HTML. Also provides the
Apache Struts framework for developing Java EE Web
applications.

No

WebSphere Portal
Server, version 6.1

The WebSphere Portal Server options provide
development tools to create, customize, test, debug, and
deploy portal applications. Select the "Tools for
developing applications without a local server
installation" option if you do not have the server
installed locally but want to develop applications for
WebSphere Portal Server.

No

WebSphere Portal
Server, version 6.1
on WebSphere
Application
Server, version 7.0

No

WebSphere Portal
Server, version 7.0

No

Lifecycle
integration clients

Provides an asset repository and provides integrations
and client plug-ins for the IBM Rational Team Unifying
Platform.

No

Asset repository
client

The asset repository client is a centrally accessible
location for storing and sharing business process
management (BPM) artifacts. IBM Rational Asset
Manager must be installed and configured on a server
so that the asset repository client can connect to it.

No

Rational
ClearCase® SCM
Adapter

Provides the IBM Rational ClearCase SCM and
ClearCase MVFS plug-ins, which enable versioning of
software artifacts in ClearCase versioned object bases
(VOBs) using snapshot views and dynamic views when
ClearCase VOB and view servers are also installed.

No

Additional
development tools

Provides relational database tools to work with tables,
views, and filters. With these tools, you can create
physical database models by means of reverse
engineering database tables or using DDL scripts. You
can also use the tools to create SQL statements, DB2
routines (such as stored procedures and user-defined
functions), and various types of files. Additionally
provides a graphical editing environment that you can
use to depict Java classes, enterprise beans and other
code elements and artifacts.

No

Installation log files
You can use install log files to examine the results of an installation session.

For detailed analysis, you can look at the logs generated in the Installation Manager data area. These logs
are available at:
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2000Windows C:\Documents and Settings\All Users\Application Data\IBM\Installation Manager\logs
or

2000Windows C:\ProgramData\IBM\Installation Manager\logs

2000Linux /var/ibm/InstallationManager/logs

Installing IBM Forms software
The IBM Forms software is included with IBM Integration Designer, and can optionally be installed.

The IBM Forms software that is bundled with IBM Integration Designer includes:
v IBM Forms Designer 4.0.0.1 - a feature that can be installed (on Windows only) as part of the IBM

Integration Designer installation.
v IBM Forms Viewer 4.0 - an optional additional product that can be installed (on Windows only) from

the product launchpad.
v IBM Forms Server 4.0 - an optional additional product, comprising IBM Forms Server API and IBM

Forms Server - Webform Server, that can be installed from the product launchpad.
1. From the launchpad, select to install either IBM Integration Designer for IBM Business Process

Manager Advanced - Process Server or IBM Integration Designer for IBM Business Monitor.

2. 2000Windows On the first Install Packages page of the Installation Manager, select IBM Forms Designer.

3. Continue the installation process. 2000Windows On the Features panel you will see IBM Forms Designer
selected. You cannot clear this choice at this stage. If you decide not to install IBM Forms Designer,
navigate back to the first Installation Manager panel and clear the check box on that panel, now when
you return to the features panel, IBM Forms will no longer be a choice.

4. Optional: On the Features page, expand IBM Business Process Manager Advanced - Process Server
or Business Monitor Server and select one or more stand-alone development profiles. The profiles are
created for you during installation to make the test environment immediately available.

5. Follow the on-screen instructions to complete the installation. See "Installing with IBM Installation
Manager" for more detailed instructions.

6. If you have downloaded the IBM Forms software as individual compressed files, then extract them
according to the following information. Otherwise, proceed to the next step.
a. Create the following folders, and extract the compressed files into them, where image_directory

contains the extracted installation image for IBM Integration Designer.

On Windows, you can install either IBM Forms Viewer or IBM Forms Server. On Linux, you can only
install IBM Forms Server.
v IBM Forms Viewer:

2000Windows \image_directory\forms_viewer\

v IBM Forms Server - API:

2000Windows \image_directory\forms_server\

2000Linux /image_directory/forms_server/

7. After you have installed IBM Integration Designer, on the product launchpad select Optional
Products Installation in the left-hand navigation.

8. 2000Windows To install IBM Forms Viewer, select Install IBM Forms Viewer 4.0 and follow the on-screen
instructions. IBM Forms Viewer provides a single interface for users to open, fill out, and save forms.

9. To install IBM Forms Server API and IBM Forms Server - Webform Server , select Install IBM Forms
Server 4.0 and follow the on-screen instructions. For more information on installing IBM Forms
Server, see the IBM Forms product documentation.
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If you are installing into an existing IBM IBM Integration Designer package, and you do not accept the
default installation directory presented by the IBM Forms installation wizard, ensure that you select a
valid installation directory where the IBM Integration Designer package is installed.

Note that the installation directory for a package is distinct from the directory where shared resources are
installed. For example, shared resources are, by default, installed in:

v 2000Windows C:\IBM\SDPShared\ for installations by an administrative user,

v 2000Windows user_home\IBM\SDPShared\ for installations by a non-administrative user,

v 2000Linux /opt/IBM/SDPShared/ for installations by an administrative user,

v 2000Linux user_home/IBM/SDPShared/ for installations by a non-administrative user.

Important: Do not select this directory to install additional software products.

If you installed IBM Integration Designer and chose not to install IBM Forms Designer, you can install
IBM Forms Designer at a later stage by following the instructions in the topic Installing fix packs and
interim fixes interactively.
Related tasks:

IBM Forms Product Documentation

Installing IBM Integration Designer silently
You can install the IBM Integration Designer product package in silent installation mode. When you
install in silent mode, the user interface is not available.

Important: Only one IBM Installation Manager is required to install multiple instances of IBM Integration
Designer.
Related reference:

System requirements for IBM Integration Designer
“Installation log files” on page 16
You can use install log files to examine the results of an installation session.

Installing IBM Integration Designer silently using the command line
You can install IBM Integration Designer using the command line. You must install silently from an
electronic installation image (not a DVD).

Before you install IBM Integration Designer, review the system requirements for the product.

Operating system and software prerequisite levels are particularly important. Although the installation
process automatically checks for prerequisite operating system patches, review the system requirements if
you have not already done so. The system requirements link lists all supported operating systems and the
operating system fixes and patches that you must install to have a compliant operating system. It also
lists the required levels of all prerequisite software.

Important: If you are installing IBM Integration Designer with its test environment as a
nonadministrative or nonroot user and you intend to install the test environment, you must install DB2
before you begin the product installation

If you do not have the prerequisite base products necessary for IBM Integration Designer installation, you
must install them as part of the silent installation. The required base products are:
v Installation Manager
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v WebSphere Application Server Network Deployment (if you are installing the test environment)
v Feature Pack for XML (if you are installing the test environment)
v Feature Pack for Service Component Architecture (SCA) (if you are installing the test environment)

The silent installation performs the following tasks:
v Installs Installation Manager if it is not already installed or updates it to the appropriate level if it is

installed.
v Installs the required base products and IBM Integration Designer.

To silently install IBM Integration Designer, complete the following steps:
1. Read and accept the license terms before installing. Adding -acceptLicense to the command line

means that you accept all licenses.
2. Run the following command:

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.

2000Windows

extract_directory\imcl install list_of_product_IDs -acceptLicense -installationDirectory location -repositories repository -showVerboseProgress -log logName.log

2000Linux

extract_directory/imcl install list_of_product_IDs -acceptLicense -installationDirectory location -repositories repository -showVerboseProgress -log logName.log

where:
v list_of_product_IDs is a list of the IDs for the products you want to install, separated by spaces.

Table 2. Product IDs

Product Product ID

IBM Integration Designer com.ibm.websphere.integration.developer.v75

IBM Forms Designer com.ibm.bpm.lotus.forms.designer.v40

Installation Manager com.ibm.cic.agent,agent_core,agent_jre

v location is the path to the directory where you want to install the products.
v repository is the path to the repository where you have extracted the files, one or more of the

following directories:
extract_directory/disk1/
extract_directory/disk1/IM_win32
extract_directory/disk1/IM_linux

For more than one repository, separate the repository locations with commas.
v logName is the name of the log file to record messages and results.

Running this command installs the product with the default features. If you want to install specific
features or make other changes, see the reference link for the command-line arguments for imcl.

3. If you also want to install the test environment, run the same command again with a different
installation directory and the required product IDs and keys:

2000Windows

extract_directory\imcl install list_of_product_IDs -acceptLicense -testInstallationDirectory location -repositories repository -properties key=value,key=value -showVerb

2000Linux

extract_directory/imcl install list_of_product_IDs -acceptLicense -testInstallationDirectory location -repositories repository -properties key=value,key=value -showVerb
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where:
v list_of_product_IDs is a list of the IDs for the products you want to install, separated by spaces.

Table 3. Product IDs for test environment

Product Product ID

IBM BPM Advanced: Process Server com.ibm.ws.WBPMPS (use for default features)

or

com.ibm.ws.WBPMPS,wps.client.feature,wps.server.feature,wps.samples.feature,wps.profile.feature
(use to install BPM Process Server with a test
environment profile)

IBM Business Monitor com.ibm.ws.WBM75 (use for default features)

or

com.ibm.ws.WBM75,wbm.core.feature,wbm.wps.profile.feature,wbm.abx.feature
(use to install IBM Business Monitor with an IBM
Business Monitor and IBM BPM Process Server profile)

WebSphere Application Server Network Deployment com.ibm.websphere.ND.v70,core.feature,samples,import.productProviders.feature,import.configLauncher.feature,consoleLanguagesSup
(includes all required features)

Feature Pack for Service Component Architecture (SCA) com.ibm.websphere.SCA.v10

Feature Pack for XML com.ibm.websphere.XML.v10

DB2 for Linux 32-bit com.ibm.ws.DB2EXP97.linuxia32

DB2 for Linux 64-bit com.ibm.ws.DB2EXP97.linuxia64

DB2 for Windows 32-bit com.ibm.ws.DB2EXP97.winia32

DB2 for Windows 64-bit com.ibm.ws.DB2EXP97.winia64

IBM Cognos BI for Windows x86 (32-bit) com.ibm.ws.cognos.v1011.winia32

IBM Cognos BI for Windows x64 (64-bit) com.ibm.ws.cognos.v1011.winia64

v location is the path to the directory where you want to install the products.
v repository is the path to the repository where you have extracted the files, one of the following

directories:
extract_directory/repository/repos_32bit
extract_directory/repository/repos_64bit

For more than one repository, separate the repository locations with commas.
v key=value is a list of the keys and values you want to pass to the installation, separated by commas.

Do not put spaces between the commas.

Table 4. Keys for test environment

Key Description

user.select.64bit.image If you are installing on a 64-bit operating system, add the
following line exactly:

user.select.64bit.image,,com.ibm.websphere.ND.v70=true

The default value is false.

user.db2.admin.username Windows only. User name with authority to access the
DB2 database. The default value is bpmadmin.

user.db2.admin.password Windows only. Password for the user name above. The
default value is bpmadmin1.

user.db2.port Port for the DB2 database. The default value is 50000.
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Table 4. Keys for test environment (continued)

Key Description

user.db2.instance.username Linux only. DB2 instance user name. The default value is
bpminst.

user.db2.instance.password Linux only. Password for the user name above. The
default value is bpminst1.

user.db2.fenced.username Linux only. Fenced user name. The default value is
bpmfenc.

user.db2.fenced.password Linux only. Password for the user name above. The
default value is bpmfenc1.

user.db2.das.username Linux only. Administration server (DAS) user name. The
default value is bpmadmin.

user.db2.das.password Linux only. Password for the user name above. The
default value is bpmadmin1.

v logName is the name of the log file to record messages and results.

Running this command installs the test environment with the default features. If you want to install
specific features or make other changes, see the reference link for the command-line arguments for
imcl.

Installation Manager installs the list of products and writes a log file to the directory that you specified.

The following example installs IBM Integration Designer and IBM Forms Designer on Windows.
imcl install com.ibm.websphere.integration.developer.v75 com.ibm.bpm.lotus.forms.designer.v40 -acceptLicense -installationDirectory C:\IBM\IntegrationDesigner\v7.5 -reposit

Related reference:

System requirements for IBM Integration Designer

Command-line arguments for imcl

Installing IBM Integration Designer silently using a response file
You can install the IBM Integration Designer product package in silent installation mode. When you
install in silent mode, the user interface is not available. Instead, you run a command to use a response
file that installs the product. You must install silently from an electronic installation image (not a DVD).

Before you install IBM Integration Designer, review the system requirements for the product.

Operating system and software prerequisite levels are particularly important. Although the installation
process automatically checks for prerequisite operating system patches, review the system requirements if
you have not already done so. The system requirements link lists all supported operating systems and the
operating system fixes and patches that you must install to have a compliant operating system. It also
lists the required levels of all prerequisite software.

Important: If you are installing IBM Integration Designer with its test environment as a
nonadministrative or nonroot user and you intend to install the test environment, you must install DB2
before you begin the product installation

If you do not have the prerequisite base products necessary for IBM Integration Designer installation, you
must install them as part of the silent installation. The required base products are:
v Installation Manager
v WebSphere Application Server Network Deployment (if you are installing the test environment)
v Feature Pack for XML (if you are installing the test environment)
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v Feature Pack for Service Component Architecture (SCA) (if you are installing the test environment)

The silent installation performs the following tasks:
v Installs Installation Manager if it is not already installed or updates it to the appropriate level if it is

installed.
v Installs the required base products and IBM Integration Designer.

To silently install IBM Integration Designer, complete the following steps:
1. Read and accept the license terms before installing. Adding -acceptLicense to the command line

means that you accept all licenses.
2. Create the response file that will install the required base products and IBM Integration Designer.

Copy one of the sample response files in the following directory to create your own response file:
To install both IBM Integration Designer and the test environment: extract_directory/disk1/
responsefiles/responsefile.install.iid.testenv.xml

To install IBM Integration Designer alone: extract_directory/disk1/responsefiles/
responsefile.install.iid.xml

3. Modify the parameters as directed in the text of the response file template to create your response file.
Make the following changes:
v Set your repository location. Choose the appropriate 32-bit or 64-bit repository, and comment out

the one that you are not using. If you are not running directly from the extract_directory/
responsefiles/BPM/ directory, point to the location of your installation repository. The repository
can be local or remote. If you are running from the DVD, copy the response file from the DVD and
point it back at the repository on the DVD.

v Set the replacement variables in the response file as follows:
– ${INSTALL_LOCATION_IM} - The location where IBM Installation Manager is already installed

or will be installed.
– ${LOCATION_ECLIPSE_CACHE} - The location of the Eclipse cache. This location must be set

only if the location has not already been defined. Comment out this line if the location has
already been set.

– ${INSTALL_LOCATION} - The location where you want to install the product.
– ${FEATURE_LIST} - The list of features for the product. This list must be replaced with the list of

features that you want installed. Follow the instructions included in the template_response.xml
file.

v If you are installing DB2 Express, follow the instructions in the template_response.xml file for
providing the necessary user IDs and passwords.

4. Run the following command:

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.

To install IBM Integration Designer and the test environment: 2000Windows

extract_directory\disk1\IM_win32\installc.exe -acceptLicense input ..\responsefiles\responsefile.install.iid.testenv.xml -log silent.log

2000Linux

extract_directory/disk1/IM_linux/installc -acceptLicense input ../responsefiles/responsefile.install.iid.testenv.xml -log silent.log

To install IBM Integration Designer alone: 2000Windows

extract_directory\disk1\IM_win32\installc -acceptLicense input ..\responsefiles\responsefile.install.iid.xml -log silent.log

2000Linux

extract_directory/disk1/IM_linux/installc -acceptLicense input ../responsefiles/responsefile.install.iid.xml -log silent.log
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Installation Manager installs any required prerequisites and IBM Integration Designer and writes a log
file to the directory you specified.
Related tasks:

Installing silently with Installation Manager

Recording a response file with Installation Manager
Related reference:

System requirements for IBM Integration Designer

Working with IBM Installation Manager
This section deals with some common tasks relating to IBM Installation Manager. For more information,
see the Installation Manager information center.
Related information:

IBM Installation Manager information center

Installing Installation Manager on Windows
If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is performed automatically if it is not already installed on your workstation. (For
more information on this process, refer to “Installing from the product launchpad” on page 8.) In other
cases, you must manually start the installation of Installation Manager.

To install Installation Manager manually:
1. Run install.exe from the IM_win32 folder in the installation image.
2. Click Next on the Install Packages page.
3. Review the license agreement on the License Agreement page and select I accept the terms in the

license agreement to accept. Click Next.
4. Click the Browse button on the Destination Folder page to change the installation location if required.

Click Next.
5. Click Install on the Summary page. When the installation process is complete, a message confirms the

success of the process.
6. Click Finish. IBM Installation Manager opens.

Installing Installation Manager on Linux
If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is performed automatically if it is not already installed on your workstation. For
more information on this process, refer to “Installing from the product launchpad” on page 8.

To install Installation Manager manually:
1. Open a terminal window with root user privileges.
2. Run install from the IM_linux folder in the installation image.
3. Click Next on the Install Packages screen.
4. Review the license agreement on the License Agreement page and select I accept the terms in the

license agreement to accept. Click Next.
5. If necessary, edit the installation directory location. Click Next.
6. Click Install on the information summary page. When the installation process is complete, a message

confirms the success of the process.
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7. Click Finish. If you start the installation of your product from the launchpad program, then the
installation of IBM Installation Manager is performed automatically if it is not already installed on
your workstation.

Starting Installation Manager on Windows
If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is performed automatically if it is not already installed on your workstation. This
automatic installation starts Installation Manager with a configured repository preference and selected
IBM Integration Designer packages. If you start Installation Manager directly, then you must set a
repository preference and choose product packages manually. For more information, see “Setting
repository preferences in Installation Manager” on page 26.

To start Installation Manager manually:
1. Open the Start menu from the Taskbar.
2. Select All Programs > IBM Installation Manager > IBM Installation Manager.

Starting Installation Manager on Linux
If you start the installation of your product from the launchpad program, then the installation of IBM
Installation Manager is performed automatically if it is not already installed on your workstation. This
automatic installation starts Installation Manager with a configured repository preference and selected
IBM Integration Designer packages. If you start Installation Manager directly, then you must set a
repository preference and choose product packages manually. For more information, see “Setting
repository preferences in Installation Manager” on page 26.

To start Installation Manager manually:
1. Open a terminal window with root user privileges.
2. Change directory to the installation directory for Installation Manager (by default,

/opt/IBM/InstallationManager/eclipse for an installation by a root user; user_home/IBM/
InstallationManager/eclipse for an installation by a non-root user) and run IBMIM.

Uninstalling Installation Manager on Windows
To uninstall Installation Manager manually:
1. Click Start > Settings > Control Panel, and then double-click Add or Remove Programs.
2. Select the entry for IBM Installation Manager and click Remove

Uninstalling Installation Manager on Linux
IBM Installation Manager must be uninstalled using the package management tool that is included with
your Linux version.

To uninstall Installation Manager manually on Linux, use one of the following methods:
v On the menu, click Applications > System Tools. Select IBM Installation Manager > Uninstall IBM

Installation Manager.
v Open a terminal window with root user privileges. Change directory to the uninstallation directory of

Installation Manager. By default, this is /var/ibm/InstallationManager/uninstall. Run ./uninstall.

Updating Installation Manager through a proxy server
Proxy servers enable connections to remote servers from behind a firewall. You can set preferences for
proxy servers in Installation Manager or in a response file. After the proxy server is enabled, the proxy
server is used for all server communications. For details on how to configure Installation Manager for a
proxy server see Internet Preferences in the Installation Manager information center.
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Silently installing and uninstalling Installation Manager
IBM Installation Manager can be silently installed and uninstalled.
Related information:

IBM Installation Manager information center

Silently installing Installation Manager
To install Installation Manager silently, extract the installer and switch to the InstallerImage_platform
subdirectory, then use the following commands:

v 2000Windows installc –-launcher.ini -acceptLicense silent-install.ini -log <log file path and
name>. For example: installc --launcher.ini -acceptLicense silent-install.ini -log c:\mylogfile.xml

v 2000Linux install --launcher.ini -acceptLicense silent-install.ini -log <log file path and
name>. For example, install --launcher.ini -acceptLicense silent-install.ini -log /root/mylogs/
mylogfile.xml

After installation, you can use Installation Manager or the Installation Manager installer to silently install
packages.

Silently uninstalling Installation Manager from Windows
To silently uninstall Installation Manager on Windows:
1. From a command line, go to the uninstall directory for the Installation Manager. By default, this is

C:\Documents and Settings\All Users\Application Data\IBM\Installation Manager\uninstall.
2. Enter the following command: uninstallc.exe --launcher.ini silent-uninstall.ini

Silently uninstalling Installation Manager on Linux
To silently uninstall Installation Manager on other platforms:
1. From a terminal window, go to the directory uninstallation directory of Installation Manager. By

default, this is /var/ibm/InstallationManager/uninstall).
2. Run the following command: uninstall --launcher.ini silent-uninstall.ini

Package groups and the shared resources directory
When you install the IBM Integration Designer package using IBM Installation Manager, you must choose
a shared resources directory (if IBM Integration Designer is the first product to be installed using
Installation Manager) and a package group.

Package groups

During the installation process, you must specify a package group for the IBM Integration Designer
package. A package group represents a directory in which packages share a common user interface or
workbench with other packages in the same group. When you install the IBM Integration Designer
package using Installation Manager, you can create a new package group or install the packages into an
existing package group. Some packages might not be able to share a package group, in which case the
option to use an existing package group will be disabled.

Note that when you install multiple packages at the same time, all the packages are installed into the
same package group.

A package group is assigned a name automatically; however, you choose the installation directory for the
package group.

You can use the IBM Packaging Utility to:
v Generate a new repository for packages
v Copy packages to a new repository
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v Delete packages that are no longer needed.

For more information see The IBM Packaging Utility .

After you create the package group by successfully installing a product package, you cannot change the
installation directory. The installation directory contains files and resources specific to the IBM Integration
Designer package installed into that package group. Eclipse plug-ins in the product package that can
potentially be used by other package groups are placed in the shared resources directory.

Shared resources directory

The shared resources directory is the directory where Eclipse plug-ins are located so that they can be used
by one or more product package groups.

Important: You can specify the shared resources directory once: the first time that you install a package.
For best results, use your largest drive for the shared resources directory. You cannot change the directory
location unless you uninstall all packages.
Related information:

IBM Installation Manager information center

Setting repository preferences in Installation Manager
If you start Installation Manager directly (for example from a repository located on a Web server), you
must specify the URL for the directory that contains the product package in Installation Manager before
you can install the product package.

By default, Installation Manager uses an embedded URL in each software development product to
connect to a repository server through the Internet and search for installable packages and new features.
Your organization may require you to redirect the repository to use intranet sites.

Note: If not installing from DVD or a local installation image, obtain the installation package repository
URL from your administrator before starting the installation process.

To add, edit, or remove a repository location in Installation Manager:
1. Start Installation Manager.
2. On the Start page of Installation Manager, click File > Preferences, and then click Repositories. The

Repositories page opens, showing any available repositories, their locations, and whether they are
accessible.

3. On the Repositories page, click Add Repository.
4. In the Add repository window, type the URL of the repository location or browse to it and set a file

path. The repository location is typically image_directory/repository.config, where image_directory
contains the extracted installation image of the product you want to install.

5. Click OK. The new or changed repository location is listed. If the repository is not accessible, a red x
is displayed in the Accessible column.

6. Click OK to exit.

Note: If you want the Installation Manager to search the default repository locations for the installed
packages, ensure that the Search service repositories during installation and updates preference on the
Repositories preference page is selected.
Related information:

IBM Installation Manager information center
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Starting IBM Integration Designer
You can start IBM Integration Designer from the desktop environment or a command-line interface.
v To start IBM Integration Designer from the desktop environment:

– 2000Windows Click Start > Programs > IBM > package group name > IBM Integration Designer 7.5. For
example, click Start > Programs > IBM > IBM Integration Designer > IBM Integration Designer
7.5.

– 2000Linux Select the product shortcut on the main menu under package group name > IBM
Integration Designer 7.5. For example, click IBM Integration Designer > IBM Integration Designer
7.5.

v To start IBM Integration Designer from a command-line:

– 2000Windows From the package group installation directory, run the wid.exe command. By default, the
package group installation directory is

C:\IBM\IntegrationDesigner\v7.5

Note: Ensure that the Windows date and time are correct and match the settings of your BIOS. If
the date and time are not correctly set, IBM Integration Designer will fail to launch with the
following error message:
Exception in org.eclipse.equinox.internal.p2.reconciler.dropins.Activator.start()
of bundle org.eclipse.equinox.p2.reconciler.dropins

– 2000Linux From the package group installation directory, run the ./wid.bin command. By default, the
package group installation directory is

/opt/IBM/IntegrationDesigner/v7.5 if you installed as an administrative user
user_home/IBM/IntegrationDesigner/v7.5 if you installed as a nonadministrative user

If you are installing IBM Integration Designer to work with the Process Center and the Process Center is
not yet installed, cancel the window that prompts for the connection. Otherwise, enter the URI of the
Process Center in the following format:
http://server_name:port number/ProcessCenter

For example:
http://myserver.toronto.com:9080/ProcessCenter

Enter your user ID and password. Click Connect.

Using the "-clean" option when starting IBM Integration Designer
The -clean option can be used on IBM Integration Designer startup and it performs several functions.

IBM Integration Designer is based on the Eclipse Platform which caches all plugin.xml files into a single
repository for quicker loading. If you used IBM Integration Designer before installing a new plug-in, you
should start IBM Integration Designer once with the -clean option.
1. From a command line, change to the package group installation directory where you installed IBM

Integration Designer.
2. Run the command to start IBM Integration Designer with the -clean option.

2000Windows wid.exe -clean

2000Linux ./wid.bin -clean

This -clean option forces IBM Integration Designer to rebuild the Eclipse repository. This applies to
anything that is installed into Eclipse by unzipping it into its plugins folder. The option also
v removes and regenerates manifest files.
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v removes cached binaries and regenerates them from the newly created manifest files.
v removes and regenerates JXE information.
v removes and regenerates the runtime plug-in registry.

Beyond this it is up to each plug-in that is listed in the configuration directory to handle what it does
when -clean is used.

It is a good practice to start up IBM Integration Designer using the -clean option after applying any
Interim Fixes. This will ensure that the plug-in registry is regenerated to reflect any changes from the
applied fixes. This only needs to be done once after applying any Interim Fix, as running with -clean
takes considerable time in regenerating the plug-in registry.

Installing on Citrix Presentation Server
You can install and run IBM Integration Designer on a Citrix Presentation Server so that multiple users
can then connect remotely from their Citrix Presentation Server clients.

Follow these instructions to install IBM Integration Designer to run on Citrix Presentation Server.

Note: Throughout this text, the terms “installer” and “product installer” refer to the user ID that installed
IBM Integration Designer.
1. When you install IBM Integration Designer on the server, ensure that you are logged on as a user

with administrator access.
2. After installing, ensure that the install directory is read-only. This is the product directory, not the

shared install directory. This step will ensure that the configuration information is written in the home
directory. If this measure is not taken, all users will end up using the same location for their
configuration area, which is not supported.

Note: Ensure that client users are granted write permission to the following directory otherwise the
integrated test environment server status cannot be detected:<installation_root>\runtimes\
bi_v75_stub\

3. When launching IBM Integration Designer from a client, the workspace is created in a directory
specified by the user.

4. In order to use the servers in the test environment, a profile is required for each nonroot user. The
product installer (who can be a root/Administrator or nonroot user) can grant write permission to the
appropriate IBM Business Process Manager files and directories to other nonroot users. The nonroot
users can then create profiles. Alternatively, the product installer can create a group for users who are
authorized to create profiles or give individual users the authority to create profiles. The following
example task shows how to create a group that is authorized to create profiles.

Configuring the Citrix Presentation Server
The installer can perform the following steps to create the “profilers” group and give the group
appropriate permissions to create a profile.
1. Log on to the IBM Integration Designer system as the product installer (the product installer can be a

root/Administrator or nonroot user).
2. Using operating system commands, do the following:

a. Create a group named “profilers”, which will contain all users who can create profiles.
b. Create a user named user1, who can create profiles.
c. Add users product_installer and user1 to the profilers group.

3. 2000Linux Log off and log back on as the installer to pick up the new group.
4. As the product installer, use operating system tools to change directory and file permissions.
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a. 2000Linux The following example assumes that the variable $WASHOME is the IBM
Business Process Manager root_installation_directoryopt/ibm/BPM/v7.5
export WASHOME=opt/ibm/BPM/v7.5
echo $WASHOME
echo "Performing chggrp/chmod per WAS directions..."
chgrp profilers $WASHOME/logs/manageprofiles
chmod g+wr $WASHOME/logs/manageprofiles
chgrp profilers $WASHOME/properties
chmod g+wr $WASHOME/properties
chgrp profilers $WASHOME/properties/fsdb
chmod g+wr $WASHOME/properties/fsdb
chgrp profilers $WASHOME/properties/profileRegistry.xml
chmod g+wr $WASHOME/properties/profileRegistry.xml
chgrp -R profilers $WASHOME/profileTemplates

b. Issue the following additional command where profile_template_name is default, dmgr,
or managed, respectively:
chmod -R g+wr $WASHOME/profileTemplates/profile_template_name/documents

The ownership of files is preserved when the files are copied to the profile directory during profile
creation. You granted write permission to the profile directory so that files copied to the profile
directory can be modified as part of the profile creation process. Files that are already in the
profileTemplate directory structure prior to the start of profile creation are not modified during
profile creation.

c. 2000Linux Issue the following additional commands:
chgrp profilers $WASHOME/properties/Profiles.menu
chmod g+wr $WASHOME/properties/Profiles.menu

d. 2000Windows The following example assumes that the variable $WASHOME is the IBM Business
Process Manager root installation directory C:\IBM\ProcServer\v7.5. Follow instructions in the
Windows documentation to give the profilers group read and write permission to the following
directories and their files:
@WASHOME\logs\manageprofiles
@WASHOME\properties
@WASHOME\properties\fsdb
@WASHOME\properties\profileRegistry.xml

You might have to change the permissions on additional files if the nonroot user encounters
permission errors. For example, if the product installer authorizes a nonroot user to delete a
profile, then product installer might have to delete the following file:

e. 2000Linux

install_root/properties/profileRegistry.xml_LOCK

f. 2000Windows

install_root\properties\profileRegistry.xml_LOCK

Give write access to the nonroot user for the file to authorize the user to delete the file. If the
nonroot user still cannot delete the profile, then the product installer can delete the profile.

The installer created the profilers group and gave the group proper permissions to certain directories and
files to create profiles. These directories and files are the only ones in the installation root of IBM
Integration Designer to which a nonroot user needs to write to create profiles.
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Modifying installations
The Modify Packages wizard in the IBM Installation Manager enables you to change the language and
feature selections of an installed product package.

Note: Close all programs that were installed using Installation Manager before modifying.

To modify an installed product package:
1. From the Start page of the Installation Manager, click Modify.
2. In the Modify Packages wizard, select the IBM Integration Designer product package and click Next.
3. On the Modify page, under Languages, select the languages for the package group, then click Next.

The corresponding national language translations for the user interface and documentation for the
packages will be installed. Note that your choices apply to all packages installed under this package
group.

4. On the Features page, select the package features that you want to install and deselect the features
that you want to remove.
a. To learn more about a feature, click the feature and review the brief description under Details.
b. If you want to see the dependency relationships between features, select Show Dependencies.

When you click a feature, any features that depend on it and any features that are its dependents
are shown in the Dependencies window. As you select or exclude features in the packages,
Installation Manager will automatically enforce any dependencies with other features and display
updated download size and disk space requirements for the installation.

5. When you are finished selecting features, click Next.
6. On the Summary page, review your choices before modifying the installation package, and then click

Modify.
7. Optional: When the modification process completes, click View Log File to see the complete log.

Updating IBM Integration Designer
You can install updates to IBM Integration Designer when they are available.

Installing fix packs interactively
You can install fix packs for IBM Integration Designer interactively.

By default, Internet access is required unless your repository preferences points to your local update site.

Each installed package has the location embedded for its default IBM update repository. For Installation
Manager to search the IBM update repository locations for the installed packages, the preference Search
service repositories during installation and updates on the Repositories preference page must be
selected. This preference is selected by default.

During the update process the repository for the base version of the package is required. If you have
deleted the files required for rollback in Installation Manager, then Installation Manager prompts for the
original installation disk when you upgrade to a fix pack. If you installed the product from DVDs or
other media, they must be available when you use the update feature.

See the Installation Manager information center for more information.

Important: If you created profiles in an earlier version, those profiles are preserved and you do not need
to re-create them.

You cannot use this procedure to install updates on the underlying IBM DB2 Express or IBM Cognos BI.
You must update these products following their normal update processes.
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To find and install product package updates:
1. Close all programs that were installed using Installation Manager before updating.
2. Start Installation Manager. From the Start page of the Installation Manager, click Update.

2000Windows You can also click Start > Programs > IBM > package group name > Update. For
example, click Start > Programs > IBM > IBM Integration Designer > Update.

3. If IBM Installation Manager is not detected on your system or if an older version is already installed,
then you must continue with the installation of the latest release. Follow the on-screen instructions in
the wizard to complete the installation of IBM Installation Manager.

4. If you do not have Internet access, download the interim fix or fix pack locally, extract it to its own
directory, and add the new directory to Installation Manager.
a. Start Installation Manager.
b. From the Start page, click File > Preferences > Repositories.
c. From the Repositories page, click Add Repository.
d. In the Add Repository window, browse to the new directory you created for the interim fix or fix

pack files.
e. Select the repository.config file and click Open.
f. From the Repositories page, click OK.

5. In the Update Packages wizard, select the package group containing the product package you want
to update or select the Update all check box, and then click Next. Installation Manager searches for
updates in its repositories and the predefined update sites for the software you are updating. A
progress indicator shows the search is taking place.

6. If updates for a package are found, then they are displayed in the Updates list on the Update
Packages page below their corresponding package. Only the latest recommended updates are
displayed by default. Click Show all to display all updates found for the available packages.
a. To learn more about an update, click the update and review its description under Details.
b. If additional information about the update is available, a More info link is included at the end of

the description text. Click the link to display the information in a browser. Review this
information before installing the update.

7. Select the updates that you want to install or click Select Recommended to restore the default
selections, and click Next. Updates that have a dependency relationship are automatically selected
and cleared together.

8. On the Licenses page, read the license agreements for the selected updates. On the left side of the
Licenses page, the list of licenses for the updates you selected is displayed; click each item to display
the license agreement text. If you agree to the terms of all the license agreements, click I accept the
terms of the license agreements. Then click Next.

9. On the Summary page, review your choices before installing the updates.
a. If you want to change the choices you made on previous pages, click Back, and make your

changes.
b. When you are satisfied, click Update to download and install the updates. A progress indicator

shows the percentage of the installation completed.
10. Optional: When the update process completes, a message that confirms the success of the process is

displayed near the top of the page. Click View log file to open the log file for the current session in
a new window. You must close the Installation Log window to continue.

11. Click Finish to close the wizard.
12. Close Installation Manager.
Related information:

IBM Installation Manager information center
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Rolling back fix packs
Using the Roll Back Packages wizard, you can remove a fix pack and revert to a previous version.

During the rollback process, Installation Manager must access files from the earlier version of the
package. By default, these files are stored on your system when you install a package. If the files are not
available on your workstation, you must include the location of the repository from which you installed
the previous version of the product in your Installation Manager preferences (File > Preferences >
Repository). If you installed the product from DVD or other media, they must be available when you use
the rollback feature.

Use the rollback feature if you have applied an update to a product package, and decide later that you
want to remove the update and revert to the earlier version of the product. When you use the rollback
feature, the Installation Manager uninstalls the updated resources, and reinstalls the resources from the
previous version.

Note: A rollback process to a stand-alone server can disable the WebSphere test environment. You must
reset the test environment profile after you complete the rollback process. To reset a test environment
profile, see Creating or resetting default server profiles.

See the help in the Installation Manager for more information on using the Rollback wizard.

To roll back an updated package, complete the following steps:
1. On the Start page of the Installation Manager, click Roll Back to start the Rollback wizard.
2. From the Roll Back Packages list, select the package that you want to roll back.
3. Complete the wizard according to the on-screen instructions.
Related information:

IBM Installation Manager information center

Installing fix packs silently
You can install fix packs for IBM Integration Designer using the command line.

You cannot use this procedure to install updates on the underlying IBM DB2 Express or IBM Cognos BI.
You must update these products following their normal update processes.

To update IBM Integration Designer silently, complete the following steps:
1. Read and accept the license terms before updating. Adding -acceptLicense to the command line

means that you accept all licenses.
2. Run the following command:

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.

2000Windows

extract_directory\imcl install com.ibm.websphere.integration.developer.v75 -acceptLicense -installationDirectory location -repositories repository -showVerboseProgress -lo

2000Linux

extract_directory/imcl install com.ibm.websphere.integration.developer.v75 -acceptLicense -installationDirectory location -repositories repository -showVerboseProgress -lo

where:
v location is the path to the directory where you want to update the products.
v repository is the path to the repository where you have extracted the fix pack files. For more than

one repository, separate the repository locations with commas.
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v logName is the name of the log file to record messages and results.
3. If you also want to update the test environment, run the same command again with the correct

installation directory and the required product IDs:

2000Windows

extract_directory\imcl install list_of_product_IDs -acceptLicense -testInstallationDirectory location -repositories repository -showVerboseProgress -log logName.log

2000Linux

extract_directory/imcl install list_of_product_IDs -acceptLicense -testInstallationDirectory location -repositories repository -showVerboseProgress -log logName.log

where:
v list_of_product_IDs is a list of the IDs for the products you want to update, separated by spaces.

Table 5. Product IDs for test environment

Product Product ID

IBM BPM Advanced: Process Server com.ibm.ws.WBPMPS

IBM Business Monitor com.ibm.ws.WBM75

WebSphere Application Server Network Deployment com.ibm.websphere.ND.v70

Feature Pack for Service Component Architecture (SCA) com.ibm.websphere.SCA.v10

Feature Pack for XML com.ibm.websphere.XML.v10

v location is the path to the directory where you want to update the products.
v repository is the path to the repository where you have extracted the fix pack files. For more than

one repository, separate the repository locations with commas.
v logName is the name of the log file to record messages and results.

Installation Manager updates the list of products and writes a log file to the directory that you specified.

The following example updates IBM Integration Designer on Windows.
imcl install com.ibm.websphere.integration.developer.v75 -acceptLicense -installationDirectory C:\IBM\IntegrationDesigner\v75 -repositories D:\temp\IID\Fixpack1 -showVerbos

Related reference:

Command-line arguments for imcl
Related information:

IBM Installation Manager information center

Uninstalling IBM Integration Designer
You can uninstall IBM Integration Designer interactively or silently.

Uninstalling IBM Integration Designer
The Uninstall option in the Installation Manager enables you to uninstall packages from a single
installation location. You can also uninstall all the installed packages from every installation location.

To uninstall the packages, you must log in to the system using the same user account that you used to
install the product packages. A package cannot be uninstalled when another package has a dependency
on it, unless the dependent package is also selected to be uninstalled.
1. Close the programs that you installed using Installation Manager.
2. Stop all running servers.
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3. From the Start page of the Installation Manager, click Update. 2000Windows You can also click Start >
Programs > IBM > package group name > Uninstall. For example, click Start > Programs > IBM >
IBM Integration Designer > Uninstall.

4. On the Uninstall Packages page, select IBM Integration Designer and associated packages and click
Next. 2000Windows If you selected Start > Programs > Uninstall in the previous step, IBM Integration
Designer is pre-selected for uninstallation on the Uninstall Packages page.

5. On the Summary page, review the list of packages that will be uninstalled and then click Uninstall.
After the uninstallation finishes, the Complete page opens.

6. Click Finish to exit the wizard.

When IBM Integration Designer is uninstalled, all profiles that are augmented to IBM Integration
Designer are removed, including any WebSphere Application Server profiles that are augmented to IBM
Integration Designer.

Uninstalling silently
You can uninstall the IBM Integration Designer product package in silent installation mode. When you
uninstall in silent mode, the user interface is not available.
Related information:

IBM Installation Manager information center

Uninstalling silently using the command line
You can use the command-line mode of the Installation Manager to uninstall IBM Integration Designer.

Close all programs that you installed using the Installation Manager.

To uninstall, you must log in to the system using the same user account that you used to install.

To uninstall IBM Integration Designer using the command line, complete the following steps:
1. Open a command prompt, and change directories to the /eclipse/tools directory under Installation

Manager.

Important: If you are running Windows 7, Windows Vista, or Windows Server 2008, start your
command prompt by right-clicking and selecting Run as administrator.

2. Make the appropriate replacements and run the following command:
imcl uninstall list_of_product_IDs -installationDirectory installationDirectory -log logLocation

a. Replace list_of_product_IDs with a list of the IDs for the products you want to uninstall,
separated by spaces.

Table 6. Product IDs

Product Product ID

IBM Integration Designer com.ibm.websphere.integration.developer.v75

IBM Forms Designer com.ibm.bpm.lotus.forms.designer.v40

Installation Manager com.ibm.cic.agent,agent_core,agent_jre

b. Replace installationDirectory with the location where you installed the product.
c. Replace logLocation with the location and file name to log the information.

3. If you also want to uninstall the test environment, make the appropriate replacements and run the
same command again:
imcl uninstall list_of_product_IDs -installationDirectory testInstallationDirectory -log logLocation
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a. Replace list_of_product_IDs with a list of the IDs for the products you want to uninstall,
separated by spaces.

Table 7. Product IDs for test environment

Product Product ID

IBM BPM Advanced: Process Server com.ibm.ws.WBPMPS (use for default features)

or

com.ibm.ws.WBPMPS,wps.client.feature,wps.server.feature,wps.samples.feature,wps.profile.feature
(use to install BPM Process Server with a test
environment profile)

IBM Business Monitor com.ibm.ws.WBM75 (use for default features)

or

com.ibm.ws.WBM75,wbm.core.feature,wbm.wps.profile.feature,wbm.abx.feature
(use to install IBM Business Monitor with an IBM
Business Monitor and IBM BPM Process Server profile)

WebSphere Application Server Network Deployment com.ibm.websphere.ND.v70,core.feature,samples,import.productProviders.feature,import.configLauncher.feature,consoleLanguagesS
(includes all required features)

Feature Pack for Service Component Architecture (SCA) com.ibm.websphere.SCA.v10

Feature Pack for XML com.ibm.websphere.XML.v10

DB2 for Linux 32-bit com.ibm.ws.DB2EXP97.linuxia32

DB2 for Linux 64-bit com.ibm.ws.DB2EXP97.linuxia64

DB2 for Windows 32-bit com.ibm.ws.DB2EXP97.winia32

DB2 for Windows 64-bit com.ibm.ws.DB2EXP97.winia64

IBM Cognos BI for Windows x86 (32-bit) com.ibm.ws.cognos.v1011.winia32

IBM Cognos BI for Windows x64 (64-bit) com.ibm.ws.cognos.v1011.winia64

b. Replace installationDirectory with the location where you installed the product.
c. Replace logLocation with the location and file name to log the information.

Installation Manager uninstalls the list of products and writes a log file to the directory that you
specified.

The following example uninstalls Integration Designer and IBM Forms Designer from Windows.
C:\Program Files\IBM\Installation Manager\eclipse\tools>imcl uninstall com.ibm.websphere.integration.developer.v75 com.ibm.bpm.lotus.forms.designer.v40 -installationDirecto

Related reference:

Command-line arguments for imcl

Uninstalling silently using a response file
You can create a response file and then run a command to use that response file to uninstall IBM
Integration Designer.

Close all programs that you installed using Installation Manager.

To uninstall, you must log in to the system using the same user account that you used to install.

To silently uninstall IBM Integration Designer, complete the following steps:
1. Create the response files that will uninstall the required base products and IBM Integration Designer.

Copy one of the sample response files in the following directory to create your own response file:
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To uninstall both IBM Integration Designer and the test environment: dvd_root/disk1/
responsefiles/responsefile.uninstall.iid.testenv.xml

To uninstall IBM Integration Designer alone: dvd_root/disk1/responsefiles/
responsefile.uninstall.iid.xml

2. Modify the parameters as directed in the text of the response file templates to create your response
files. You can also create response files by recording your actions in Installation Manager. When you
record a response file, the selections that you make in Installation Manager are stored in an XML file.
When you run Installation Manager in silent mode, Installation Manager uses the data in the XML
response file to perform the installation.

3. Run the following command to uninstall both IBM Integration Designer and the test environment:

2000Windows

IM_location\tools\imcl.exe input extract_location\disk1\responsefiles\responsefile.uninstall.iid.testenv.xml -log silentuninstall.log

2000Linux

IM_location/tools/imcl input extract_location/disk1/responsefiles/responsefile.uninstall.iid.testenv.xml -log silentuninstall.log

Run the following command to uninstall IBM Integration Designer alone: 2000Windows

IM_location\tools\imcl.exe input extract_location\disk1\responsefiles\responsefile.uninstall.iid.xml -log silentuninstall.log

2000Linux

IM_location/tools/imcl input extract_location/disk1/responsefiles/responsefile.uninstall.iid.xml -log silentuninstall.log

Installation Manager uninstalls IBM Integration Designer and writes a log file to the directory that you
specified.
Related information:

IBM Installation Manager information center

Troubleshooting the installation process
There are a few problems you might encounter when installing or removing IBM Integration Designer.

The table provides a list of problems, descriptions and solutions.

Table 8. Possible problems with installation.

Issue Solution

Exceptions thrown during installation of IBM Integration
Designer. The Installation Manager log files contain the
following error:

java.io.Exception: CreateProcess: "C:\...\security.update.bat" error = 5

The error indicates file-access permission problems. This
problem can be caused by anti-virus software interfering
with the installation process.

Ensure that you have sufficient permissions to install on
this system and disable anti-virus software while you
install IBM Integration Designer.
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Table 8. Possible problems with installation. (continued)

Issue Solution

The test server does not appear in the Servers view. 1. Verify the profile was created. The default profiles
directory is one of the following directories:

2000Windows C:\Program Files\IBM\WebSphere\
AppServer\profiles\

2000Windows C:\Program Files\WebSphere\
AppServer\profiles\

2000Linux /opt/IBM/WebSphere/AppServer/
profiles/

2000Linux /opt/IBM/WebSphere/AppServer/
profiles/

2. Open a command prompt and navigate to the
directory where IBM Integration Designer is installed.
Enter the following command:

2000Windows wid.exe -clean

2000Linux ./wid.bin -clean

3. If the server still does not appear, create a new server
following the instructions in Creating servers in the
test environment.

Reinstalling cannot create new profile.

If you try to reinstall to the same location, or if you try
to reinstall after a failed uninstall, the installation might
fail because a new profile cannot be created.

If databases were created for the test environment, the
databases must be dropped before you can create a new
profile.

If the databases are not automatically dropped during
uninstall, you must drop them manually.

v For the qesb profile, the default databases are
ECMNDB and QECMNDB (one or both)

v For the qbpmaps profile, the default databases are
QBPMDB, QPDWDB, and QCMNDB

v For the qmwas profile, the default databases are
MONITOR and COGNOSCS

v For the qmbpmaps profile, the default databases are
QBPMDB, QPDWDB, QCMNDB, MONITOR, and
COGNOSCS

v For the qmesb profile, the default databases are
ECMNDB, QECMNDB, MONITOR, and COGNOSCS
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